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Overview of Lesson 

• Introduction 

• Distribution Concepts 

•	 Launching the Data Distribution Operator and 
Storage Management Control GUIs 

• Monitoring/Controlling Distribution Requests 

• Modifying Preambles 

•	 Configuring Storage Management Polling and 
Deleting Files from Cache 

•	 Monitoring Storage Management Server 
Operations 
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Overview of Lesson (Cont.) 

• Tuning System Parameters 

• Troubleshooting Data Distribution Problems 

• Practical Exercise 
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Objectives 

• OVERALL: 
– Develop proficiency in the procedures that apply to 

data distribution operations 

• SPECIFIC: 
– Describe the general functions and processes 

associated with data distribution 

– Perform the steps involved in... 
» launching the Data Distribution Operator and Storage 

Management Control GUIs 

» monitoring/controlling data distribution requests 

» modifying an e-mail preamble 

» configuring Storage Management polling functions 

» deleting files from cache 
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Objectives (Cont.) 

• SPECIFIC (Cont.): 
– Perform the steps involved in... 

» viewing Storage Management Event Log information 

» monitoring Storage Management server operations 

» modifying system parameters in database tables 

» troubleshooting data distribution problems 

5 

625-CD-609-001 



Objectives (Cont.) 

• STANDARDS: 
– Lesson content (procedures in the lesson) 

– Mission Operation Procedures for the ECS Project 
(611-CD-600-001) 
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Distribution Concepts 

• ECS Context 
– Data distribution for ECS is accomplished at the 

Distributed Active Archive Centers (DAACs) 

– People involved in data distribution activities are 
Ingest/Distribution Technicians 

– Data Server Subsystem (DSS), which manages 
access to the data archive, is key to data 
distribution as well as several other functions 

– Computer software configuration items (CSCIs) in 
DSS 

» DDIST 

» STMGT 

» SDSRV 
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Distribution Concepts (Cont.) 

• ECS Context (Cont.) 
– DDIST CSCI formats and distributes data to users 

» Accepts requests from the SDSRV CSCI 

» Directs the STMGT CSCI to transfer data 

– STMGT CSCI stores, manages, and retrieves data 
files on behalf of other science data processing 
components 

» Provides interfaces that allow Data Distribution to 
obtain access to disk space 

» Maintains a user pull area that supports electronic 
pull distribution 

» Provides for the copying of files into the archive for 
permanent storage 
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Distribution Concepts (Cont.) 

• ECS Context (Cont.) 
– SDSRV CSCI manages and provides user access to 

collections of non-document Earth Science data 
» Checks/verifies metadata 

» Issues requests to the STMGT and DDIST CSCIs to 
perform storage and distribution services in support 
of the processing of service requests, such as 
insertion of data into the archive or distribution of 
data products from the archive 

– Product Distribution System (PDS) (a recent 
addition to ECS) supports the distribution of data 
on the following types of media: 

» 8mm tape cartridges 

» Digital Linear Tape (DLT) 

» Compact disk (CD) 

» DVD (formerly digital video disk or digital versatile 
9disk now referred to as just "DVD") 
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Distribution Concepts (Cont.) 

• ECS Context (Cont.) 
– A description of PDS is described in an addendum 

to the lesson 
» Includes procedures for the distribution of data on 

hard media 
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Distribution Concepts (Cont.) 

• DDIST 
– Data Distribution Operator GUI (EcDsDdistGui) 

– Distribution Server (EcDsDistributionServer) 

– Sybase Adaptive Server Enterprise (ASE) Server 
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Data Server Subsystem: 
DDIST Architecture and Interfaces 

EcDsDistributionServer 

EcDsDdistGui 
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STMGT/DDIST 
Database 

Ingest Local Disk 
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Distribution Concepts (Cont.) 

• DDIST (Cont.) 
– Start-up script used by Ingest/Distribution 

Technicians (/usr/ecs/MODE/CUSTOM/utilities 
directory on the Distribution Server host) 

» EcDsDdistGuiStart 

– Start-up scripts called by other applications (not 
normally invoked directly by Ingest/Distribution 
Technicians) 

» EcDsDataDistributionAppStart 

» EcDsDdStart 

» EcDsDistributionServerStart 

– Other scripts 
» DsDdSendMailPl.pl 

» EcDsDdPTEdit.pl 
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Distribution Concepts (Cont.) 

• STMGT 
– Archive Server (EcDsStArchiveServer) 

– Staging Servers 
» Cache Manager Server (EcDsStCacheManagerServer) 
» Pull Monitor (EcDsStPullMonitorServer) [symbolic 

link to the Cache Manager Server] 
» Staging Disk Server (EcDsStStagingDiskServer) 

– Resource Managers 
» 8mm Server (EcDsSt8MMServer) 

» D3 Server (EcDsStD3Server) 

» FTP Server (EcDsStFtpServer) 

– Storage Management Request Manager 
(EcDsStRequestManagerServer) 

– Storage Management Control GUI (EcDsStmgtGui) 
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Distribution Concepts (Cont.) 

• STMGT (Cont.) 
– Sybase ASE Server 

– Archival Management and Storage System (AMASS) 
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STMGT Architecture and Interfaces

ASE (Sybase)

STMGT/DDIST
Database

AMASS

Disk
Index
File

Staging
Data
List

Device Info
Request List

EcDsStArchiveServer
EcDsStCacheManagerServer

EcDsSt8MMServer
EcDsStD3Server
EcDsStDLTServer
EcDsStCDROMServer

EcDsStFtpServer

EcDsStPullMonitorServer

EcDsStmgtGui

EcDsStStagingDiskServer

FTP Daemon

Resource
List

EcDsStRequestManagerServer



Distribution Concepts (Cont.) 

• STMGT (Cont.) 
– Start-up script used by Ingest/Distribution 

Technicians (/usr/ecs/MODE/CUSTOM/utilities 
directory on the Distribution Server host) 

» EcDsStmgtGuiStart 
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Distribution Concepts (Cont.) 

• STMGT (Cont.) 
– Start-up scripts called by other applications (not 

normally invoked directly by Distribution personnel) 
» EcDsStFtpServerStart 

» EcDsStStagingDiskServerStart 

» EcDsStStart 

» EcDsStStorageMgmtAppStart 

» EcEcsAppStart 

» EcDsStArchiveServerStart 

» EcDsStCacheManagerServerStart 

» EcDsStRequestManagerServerStart 

» EcDsSt8MMServerStart 

» EcDsStD3ServerStart 

» EcDsStDLTServerStart 

» EcDsStCDROMServerStart 19 
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Distribution Concepts (Cont.) 

• STMGT (Cont.) 
– Other scripts 

» EcDsCheckArchive 

» EcDsStConfigVolGrps 

» EcDsStDbBuild 

» EcDsStDbDrop 

» EcDsStDbDump 

» EcDsStDbDumpTrans 

» EcDsStDbLoad 

» EcDsStDbLoadTrans 

» EcDsStDbPatch 

» EcDsStFilesPerTapeUtility 

» EcDsStVolGrpCreateMain.pl 
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Distribution Concepts (Cont.) 

• SDSRV 
– Science Data Server (EcDsScienceDataServer) 

– Hierarchical Data Format (HDF) EOS Server 
(EcDsHdfEosServer) 

– Granule Deletion Administration Tool 
(EcDsGranuleDelete) 

– Science Data Server GUI (EcDsSdSrvGui) 

– Autometric Spatial Query Server (SQS) 

– Sybase ASE Server 
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Data Server Subsystem: 
SDSRV Architecture and Interfaces 

EcDsScienceDataServer 

EcDsSdSrvGui 

ASE (Sybase) 

ECS Inventory 
Database 
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Spatial Query 
Server (SQS) 

EcDsGranuleDelete 
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Distribution Concepts (Cont.) 

• SDSRV (Cont.) 
– Start-up script (/usr/ecs/MODE/CUSTOM/utilities 

directory on the SDSRV Server host and the 
Operations Workstation) 

» EcDsSdSrvGuiStart 
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Distribution Concepts (Cont.) 

• SDSRV (Cont.) 
– Other scripts 

» EcTsDsClientDriverStart 

» EcDsSrConvertEvt 

» EcDsSrDbBuild 

» EcDsSrDbDrop 

» EcDsSrDbDump 

» EcDsSrDbLoad 

» EcDsSrDbMigrate 

» EcDsSrDbPatch 

» EcDsSrDbValids 
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Distribution Concepts (Cont.) 

• System Changes for Release 6A 

– Increased data processing load at certain DAACs in 
support of… 

» Reprocessing of Terra satellite data in addition to 
routine processing of Terra data (essentially doubles 
the previous Terra processing load) 

» Processing of data from the Aqua satellite 
(Release 5B supported Aqua Science Software 
Integration and Test (SSI&T) only) 

– Greater volume of data to be ingested 

» Supports more interfaces and a larger number of 
Earth Science Data Types (ESDTs) 

– Higher volume of data products to be distributed 
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Distribution Concepts (Cont.) 

• System Changes for Release 6A (Cont.) 

– ECS hardware configuration upgrades for 
Release 6A 

» Replacement of the Fiber Distributed Data Interface 
(FDDI) networks with gigabit Ethernet networks at 
two DAACs [i.e., Goddard Spaceflight Center (GSFC) 
and Earth Resources Observation Systems Data 
Center (EDC)] 

» The gigabit Ethernet networks are expected to handle 
the increased throughputs of Terra reprocessing 
along with routine processing for Aqua 

» Addition of an SGI Origin processor to the Science 
Processing configuration at GSFC to handle the 
additional Aqua MODIS processing load 

» Replacement of SGI Challenge archive machines with 
SGI Origin machines 
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Distribution Concepts (Cont.) 

• System Changes for Release 6A (Cont.) 

– ECS hardware configuration upgrades for 
Release 6A (Cont.) 

» Upgrading of Science Data Server configurations 
(both the SDSRV and Sybase/SQS hosts) at EDC and 
GSFC so that the request load is shared between two 
separate host configurations 

» Additional staging disks in the Release 6A 
configuration to handle increased Ingest and Data 
Distribution loads 
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Distribution Concepts (Cont.) 

•	 Data Distribution is a process of retrieving 
archived data and providing the data to 
requesters in response to the orders they 
submit 

– external requesters 

– internal processes 

•	 Data retrieved from the archives can be 
distributed to requesters using either of the 
following three general methods: 

– Electronic pull 

– Electronic push 

– Hard (physical) media distribution on disks or tape 
cartridges [distributed through the Product 
Distribution System (PDS)] 
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Distribution Concepts (Cont.) 

•	 Method of data distribution is dictated by the 
nature of the data distribution request 

– Requester specifies the distribution method when 
ordering or subscribing to the data 
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Distribution Concepts (Cont.) 

• Electronic Pull: 
– Requester searches for a specific data product 

– Requester submits an order for a “pull” of the data 
using file transfer protocol (ftp) 

– STMGT retrieves the specified data from the archive 
and places it on the pull disk 

– DDIST builds an e-mail notification that the 
requester’s order has been filled 

– Message is sent via e-mail to the requester’s e-mail 
address, which is determined from the User Profile 

– Requester pulls (transfers) the data from the Data 
Server pull disk to the requester’s own system 

– Data are deleted from the pull disk in accordance 
with DAAC policy 
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Distribution Concepts (Cont.) 

• Electronic Push: 
– Requester searches for a specific data product 

– Requester submits an order for ftp “push” of the 
data 

– Data are retrieved from the archive, placed on the 
Data Server staging disk and pushed (transferred) 
to the requester's system 

– DDIST builds an e-mail notification that the 
requester’s order has been filled 

– Message is sent via e-mail to the requester’s e-mail 
address, which is determined from the User Profile 

– Data are deleted from the staging disk in 
accordance with DAAC policy 
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Distribution Concepts (Cont.) 

• Physical Media Distribution: 
– Requester searches for a specific data product 

– Requester submits an order for shipment of data on 
a physical medium 

− If an order to be delivered on a physical medium is 
for a product other than a Landsat-7 product, the V0 
Gateway forwards the order to the Product 
Distribution System (PDS) 

− For Landsat-7 products, the V0 Gateway first 
forwards the order to be delivered on a physical 
medium to the Distributed Ordering, Research, 
Reporting and Accounting Network (DORRAN) at 
the Earth Resources Observation Systems (EROS) 
Data Center (EDC); then when the gateway receives 
a validated Product Request from DORRAN, it 
forwards the Landsat-7 order to the PDS 
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Distribution Concepts (Cont.) 

• Physical Media Distribution (Cont.): 
− For each order it receives from the V0 Gateway, the 

PDS orders the requested data from the ECS using 
the Science Data Server (SDSRV) Command Line 
Interface (SCLI) 

» The PDS may break up large orders into smaller sets 
and may elect to order granules for a request 
individually 

− ECS delivers the data to the PDS using its standard 
ftp push data distribution capability 

− The PDS transfers the data to the specified physical 
medium 

− The PDS e-mails a data distribution notice (order 
shipment notification) to the user and (for 
Landsat-7 orders) to DORRAN 

– The PDS updates the ECS order tracking database 
to completed status 
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Launching Data Distribution and 
Storage Management GUIs 

•	 Software applications associated with Data 
Distribution 

– Data Distribution Operator GUI (EcDsDdistGui) 

– Distribution Server (EcDsDistributionServer) 

– Sybase ASE Server 

•	 Data Distribution depends on a number of 
related servers, especially… 

– Science Data Server servers 

– Storage Management servers 
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Launching Data Distribution and 
Storage Management GUIs (Cont.) 

•	 Software applications associated with 
Storage Management 

– Storage Management Control GUI (EcDsStmgtGui) 

– Archive Server (EcDsStArchiveServer) 

– Cache Manager Server 
(EcDsStCacheManagerServer) 

– Pull Monitor (EcDsStPullMonitorServer) 

– Staging Disk Server (EcDsStStagingDiskServer) 

– FTP Server (EcDsStFtpServer) 

– 8mm Server (EcDsSt8MMServer) 

– D3 Server (EcDsStD3Server) 

– Storage Management Request Manager 
(EcDsStRequestManagerServer) 
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Launching Data Distribution and 
Storage Management GUIs (Cont.) 

•	 Software applications associated with 
Storage Management (Cont.) 

– Sybase ASE Server 

– Archival Management and Storage System (AMASS) 
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Launching Data Distribution and 
Storage Management GUIs (Cont.) 

•	 Use UNIX command line to gain access to 
GUIs 

•	 Procedure (Launching the Data Distribution 
Operator and Storage Management Control 
GUIs) 

– Log in to the distribution server GUI host using 
secure shell 

– Change directory to the utilities directory 

– Enter the command to start the Data Distribution 
Operator GUI 

– Enter the command to start the Storage 
Management Control GUI 
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Data Distribution Operator GUI: 
Distrib'n Requests Tab 
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Storage Management Control GUI: 
Storage Config. Tab 
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Monitoring/Controlling Data 
Distribution Requests 

•	 Data Distribution activities are monitored and 
controlled using…. 

– Data Distribution Operator GUI 

– Storage Management Control GUI 

•	 DAAC Ingest/Distribution Technician 
monitors and manages data distribution 
requests primarily via the Data Distribution -
Track Activity window of the Data Distribution 
Operator GUI 
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Monitoring/Controlling Data 
Distribution Requests (Cont.) 

•	 From the Data Distribution - Track Activity 
window the DAAC Ingest/Distribution 
Technician can perform the following 
functions: 

– View data distribution requests 

– Change the priority of a selected request 

– Cancel, suspend, or resume processing of a 
request 

– Edit a suspended request to the selected media 
type 

– Filter on all or specific requests by... 
» Request ID 

» Requester 

» Media Type 
41 
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Monitoring/Controlling Data 
Distribution Requests (Cont.) 

•	 The Data Distribution - Track Activity window 
displays the following information (plus 
additional information) for each data 
distribution request: 

– Request ID 

– Requester 

– ESDT Type 

– Media type 

– Priority 

– State 

– Estimated # of Media 

– Total Size [of the request] 

– # of Files 
42 
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Monitoring/Controlling Data 
Distribution Requests (Cont.) 

• Procedure 
– Configure data distribution polling (subordinate 

procedure) 

– Observe data distribution request information 
displayed in the Data Distribution Requests list 

– Filter requests as necessary (subordinate 
procedure) 

– Change the priority of distribution requests 
(subordinate procedures) 

– Change the status of distribution requests 
(subordinate procedures) 

» Suspend requests 

» Resume processing of suspended requests 

» Cancel requests 
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Configuring Data Distribution 
Polling 

•	 Refresh Options Dialogue from the Data 
Distribution Operator GUI Options menu is 
used for... 

– switching the Data Distribution database polling 
function on or off 

– modifying DDist Polling Rate 
» specifies how often (in seconds) the system updates 

the information displayed in the Data Distribution -
Track Activity window 

– modifying Error Retry Rate 
» specifies the amount of time (in seconds) that the 

system waits before trying to poll the Data Server 
after a failed attempt 
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Configuring Data Distribution 
Polling (Cont.) 

• Procedure 
– Select Options →  System Settings from the pull­

down menu of the Data Distribution Operator GUI 

– Click on the DDist Polling On button to change the 
state of polling 

– Enter value for the polling rate 
» default value is 30 seconds 

– Enter value for the error retry rate 

– Click on the Ok button to apply the values and 
dismiss the dialogue box 
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Refresh Options Dialogue Box 
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Filtering Data Distribution Requests 

• Filtering Data Distribution Requests 
– Data distribution requests can be filtered with 

respect to the following criteria: 
» request ID 

» requester 

» media type 

» state 

– Procedure 
» Select View → Filter 

» Select filter criteria 

» Click on the OK button to implement the selections 
and dismiss the dialogue box 
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Distribution Filter Requests 
Dialogue Box 
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Changing the Priority of Data 
Distribution Requests 

• Procedure 
– Highlight the distribution request to be assigned a 

different priority 

– Select the new priority using the Change Priority 
button 

– Click on the Apply button to implement the priority 
change 
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Suspending/Resuming Data 
Distribution Requests 

•	 Under certain circumstances it may be 
advisable to suspend the processing of a data 
distribution request and resume it at a later 
time 

• Procedure 
– Click on the Suspend New Requests button to 

suspend all new distribution requests 

– Select the individual distribution request to be 
suspended and click on the Suspend button to 
suspend a single distribution request 

– Click on the Resume New Requests button to 
resume processing of all new distribution requests 

– Select the individual distribution request for which 
processing is to be resumed and click on the 
Resume button to resume processing of a single 

50distribution request 
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Canceling Data Distribution 
Requests 

•	 Sometimes it may be necessary to cancel the 
processing of a data distribution request 

• Procedure 
– Select the distribution request to be canceled 

– Click on the Cancel button 
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Modifying Preambles 

•	 Preamble Editor tab on the Data Distribution 
Operator GUI allows the Ingest/Distribution 
Technician to review and/or modify the text of 
preambles to the following types of 
documents: 

– Packing list 
– Successful e-mail 
– Failed e-mail 

•	 Preambles for different types of distribution 
are accessible in the 
/usr/ecs/MODE/CUSTOM/data/DSS directory 
on the Distribution Server host 

• Types of media relevant to Release 6A: 
– Ftp pull 
– Ftp push 52 
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Data Distribution Operator GUI: 
Preamble Editor Tab 
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Data Distribution Operator GUI: 
FTP Push Failed E-Mail Preamble 
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Modifying Preambles (Cont.) 

• Procedure 
– Select the Preamble Editor tab of the Data 

Distribution Operator GUI 
– Select the appropriate media type 
– Select the appropriate preamble type 
– Edit the preamble text 
– Save the edited preamble 
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Preamble Save Confirmation 
Dialogue Box 
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Configuring STMGT Polling & 
Deleting Files from Cache 

•	 Configuring Storage Management Polling 
(Storage Management Control GUI Options 
menu) 

– Switch database polling functions on or off 
» Operator Notification Timer [e.g., polling for 

displaying Event Log data] 
» Cache Statistics Timer [polling for displaying cache 

statistics data] 

– Modify parameters relevant to the Operator 
Notification Timer 

» Database Polling Rate 
» Error Retry Rate 

– Modify parameter relevant to the Cache Statistics 
Timer 

» Database Polling Rate 
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Storage Management Control GUI: 
Session Settings Dialogue 
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Configuring STMGT Polling & 
Deleting Files from Cache (Cont.) 

•	 Configuring Storage Management Polling: 
Procedure 

– Select Options → System Settings from the pull­
down menu on the Storage Management Control 
GUI 

– Set the Operator Notification Timer and/or Cache 
Statistics Timer to the appropriate polling states 
(off or on) if applicable 

– Enter the database polling rate for the Operator 
Notification Timer and/or Cache Statistics Timer if 
applicable 

– Set the error retry rate for the Operator Notification 
Timer if applicable 

– Apply the modifications 
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Configuring STMGT Polling & 
Deleting Files from Cache (Cont.) 

•	 Cache Stats. tab on the Storage Management 
Control GUI 

– Displays all of the files that are in the cache areas, 
including the Pull Monitor and other staging areas 

– Displays general statistics on the selected cache 
– Allows the operator to delete expired files in cache 

areas 
– If a cache area reaches an operator-configurable 

threshold, the operator receives a warning message 
in the operator messages area of the GUI 

– If expired files are not deleted and the cache fills 
completely, the server is not able to copy new files 
to the cache area 
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Storage Management Control GUI: 
Cache Stats. Tab 
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Configuring STMGT Polling & 
Deleting Files from Cache (Cont.) 

• Deleting Files from Cache: Procedure 

– Select the Cache Stats. tab on the Storage 
Management Control GUI 

– Select the cache containing the files to be deleted 

– Select the file to be deleted from the cache 

– Click on the Mark Delete button 

– If any file has been inadvertently marked Delete, 
first click on the row corresponding to the file then 
click on the Unmark Delete button 
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Configuring STMGT Polling & 
Deleting Files from Cache (Cont.) 

•	 Viewing Storage Management Event Log 
Information: Storage Events tab on the 
Storage Management Control GUI 

– Search the Event Log 
– Obtain reports on events that have occurred in 

Storage Management 
– Review information concerning a particular Storage 

Management event 
» Number 
» Date 
» Level 
» Type 
» Message 

63 

625-CD-609-001 



Configuring STMGT Polling & 
Deleting Files from Cache (Cont.) 

• Storage Events tab (Cont.) 
– Search criteria (can be used individually or in 

combination to view entries in the Event Log) 
» Date Interval 
» Event Type 
» Event Level 
» Message 
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Storage Management Control GUI: 
Storage Events Tab 
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Configuring STMGT Polling & 
Deleting Files from Cache (Cont.) 

•	 Viewing Storage Management Event Log 
Information: Procedure 

– Select the Storage Events tab of the Storage 
Management Control GUI 

– Enter the defining characteristic(s) (e.g., time 
period, event type, event level) of the event 

– Click on the Search button to search the event log 
for events that meet the specified criteria 

– Observe event information displayed in the Event 
Log window 
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Monitoring Storage Management 
Server Operations 

•	 The Request Status tab on the Storage 
Management Control GUI 

– Makes it possible to monitor processing activity in 
all of the storage management servers for a given 
mode 

• Request Status Information table 

– Lists the requests that are currently being serviced 
by storage management servers and those that 
have been completed within the last 24 hours 

– Using the Request Status tab the Ingest/Distribution 
Technician can detect stalled requests or servers 
that appear to be idle 
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Monitoring Storage Management 
Server Operations (Cont.) 

• Request Status Information table contents 

– Operation [type of operation] 

– Request ID 

– Progress [current stage of processing] 

– Status 

– Priority 

– When Submitted [time and date received by the 
server that is responsible for the request] 

– Last Updated [time and date status was last 
updated] 
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Monitoring Storage Management 
Server Operations (Cont.) 
• Procedure 

– Click on the Storage Management Control GUI 
Request Status tab 

– Observe information displayed on the Request 
Status tab of the Storage Management Control GUI 

– If necessary, filter the list of Storage Management 
requests shown in the Request Status Information 
table by making the appropriate selection from the 
Filtering pull-down menu: 

» Server 
» Operation 
» Processing State 
» Submitter 

– Observe the Storage Management requests 
displayed in the Request Status Information table 

– To exit from the Storage Management Control GUI 
69 select File → Exit from the pull-down menu 
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Storage Management Control GUI: 
Request Status Tab 
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Tuning System Parameters 

•	 System parameters may be subject to control 
by Configuration Management (CM) 

– When making or requesting a change to system 
parameters, the CM process at the particular site 
must be followed (if applicable) 

• Two databases where parameters can be set: 
– STMGT/DDIST database 
– Configuration Registry database 
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Tuning System Parameters (Cont.) 

• Configuration Registry 
– Configuration Registry Server provides a single 

interface (via a Sybase server) for retrieving 
configuration attribute-value pairs for ECS servers 
from the Configuration Registry database 

» When ECS servers are started they access the 
Configuration Registry database to obtain needed 
configuration parameters 

– Database Administrator has access to a 
Configuration Registry GUI for viewing and editing 
configuration data in the database 

– It is necessary to coordinate with the Database 
Administrator when changes to configuration 
parameters are needed 

– Changes to configuration-controlled parameters are 
subject to approval through the site CM process 
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Tuning System Parameters (Cont.) 

•	 Default and adjusted values assigned to 
system parameters vary from site to site 

– For guidance concerning the assignment of values 
to parameters included in the Configuration 
Registry refer to document 910-TDA-022, Custom 
Configuration Parameters 

» Document is available at 
http://cmdm.east.hitc.com/baseline/ 
under “Technical Documents” 
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Tuning System Parameters (Cont.) 

•	 Parameters whose values may be modified to 
enhance system functioning or performance 

– AppLogSize 
» Maximum size of the application log (ALOG) file for a 

particular application 

– AppLogLevel 
» Level of detail provided in the ALOG file for a 

particular application 

– DebugLevel 
» Level of detail provided in the debug log file for a 

particular application 
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Tuning System Parameters (Cont.) 

• Tuning parameters (Cont.) 
– DBMaxConnections 

» Maximum number of database connections allowed a 
particular application 

– FtpPushThreshold 
» Maximum number of bytes per distribution request 
» The FtpPushThreshold should always be greater than 

the size of the largest input granule used by the 
Planning and Data Processing Subsystems (PDPS) in 
order to ensure that PDPS distribution requests are 
processed without manual intervention 

» When a distribution request exceeds a threshold 
(FtpPushThreshold or FtpPullThreshold), the request 
is suspended in DDIST 
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Tuning System Parameters (Cont.) 

• Tuning parameters (Cont.) 
– FtpPullThreshold 

» Maximum number of bytes per distribution request 

– Checksum Status 
» Check-summing can be enabled or disabled for either 

acquires or inserts 
» Checksum calculation is a highly time-consuming 

process, and makes intensive use of central 
processing unit (CPU) resources 

» Enabling check-summing has significant effects on 
both archive server and Cache Manager server 

– ListenThreads 
» Number of listen threads assigned to a particular 

application 
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Tuning System Parameters (Cont.) 

•	 When the value assigned to a parameter has 
been changed and saved in the Configuration 
Registry, the modified value does not take 
effect until the affected server has been 
restarted 

• Example 
– Debug level for the Distribution Server log has been 

changed from “2” to “3” in the Configuration 
Registry 

– Modification does not affect the recording of data in 
the log until after a warm restart of the Distribution 
Server (at which time the server would read the 
parameters in the Configuration Registry) 
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Modifying System Parameters in 
the Database 

•	 When making or requesting a change to 
system parameters, the CM process at the 
particular site must be followed (if applicable) 

• Staging Area Size and Read-Only Cache Size 
– The DsStConfigParameter table in the Storage 

Management and Data Distribution database 
» TotalSpace column contains the total size of raid 

allocated to the associated Cache Manager and 
staging disk combined 

» CacheSpace column contains the amount of read­
only cache space allocated/available on disk (to the 
associated Cache Manager/staging disk) in block­
size increments 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Staging area size and read-only cache size 
parameters are tuned in tandem 

– They determine…. 
» How much disk space is available for staging of files 

(both for Ingest and acquires) 
» How large is the read-only cache 

– When either area is exhausted, requests hang until 
space becomes available 

– The parameters are modified using the Storage 
Management Control GUI 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Staging area size and read-only cache size 
parameters (Cont.) 

– Pull area read-only cache size defaults to 
2,000,000,000 (blocks) 

» There is no need for much user space because the 
user files are symbolically linked back to the files in 
the read-only cache 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Staging area size and read-only cache size 
parameters (Cont.) 

– Staging area read-only cache size depends on the 
server and the data being handled 

» Staging read-only cache comes out of the same disk 
space as staging disk; the greater the need for 
staging disk, the smaller the size of the read-only 
cache 

» If the staging disk is being used primarily to link files 
from the read-only cache, the read-only cache can 
take most of the total staging area (90% or so) 

» If data is being staged in support of Ingest or 
subsetting of data for distribution, the read-only 
cache should be smaller (e.g., 40% or 50% of the total 
staging area) 
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Modifying System Parameters in 
the Database (Cont.) 

• Setting the FTP Pull Expiration Time 
– DsStConfigParameter table in the Storage 

Management and Data Distribution database 
» PullExpirationTime column 
» Value listed for a particular pull monitor server 

specifies the duration (in hours) after which files may 
be considered for deletion 

– Ftp pull expiration time is used as a cleanup 
mechanism for files that have not been pulled 

– Appropriate setting for the ftp pull expiration time 
depends on the following factors: 

» Frequency of files being left behind in the pull area 
(the more files, the lower the expiration time) 

» Size of the files (the bigger the files, the lower the 
expiration time) 

» Capacity of disk used (the higher the capacity used, 
the lower the expiration time) 
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Modifying System Parameters in 
the Database (Cont.) 

• Setting the FTP Pull Expiration Time (Cont.) 
– Pull expiration time defaults to 24 hours 
– Parameter is modified using the Storage 

Management Control GUI 
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Modifying System Parameters in 
the Database (Cont.) 

• Priority Thread Allocation 
– DsDdPriorityThread database table holds the 

threshold for the number of threads that can be 
active for each priority level of distribution requests 

– Priorities are set in one of two ways 
» Via a Perl script (EcDsDdPTEdit.pl) 
» Through interactive structured query language (isql) 

commands 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Modifying System Parameters in the Database 
Using the Storage Management Control GUI 

– As previously mentioned the effects on system 
functioning and performance must be considered 
before modifying system parameters 

– When making or requesting a change to system 
parameters, the CM process at the particular site 
must be followed (if applicable) 

– Depending on circumstances (e.g., operator 
permissions) at a particular site, it may be 
necessary to request that someone else make 
parameter modifications using the Storage 
Management Control GUI 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Modifying System Parameters in the Database 
Using the Storage Management Control GUI: 
Procedure 

– Click on Cache Manager in the Server Type 
Information window on the Storage Config. tab 

– Click on the appropriate server in the server 
information window 

– Click on the Modify Server/View Stackers button 

– Enter modified data in relevant field(s) as necessary 

– If service threads are to be allocated by priority, 
type the desired values in the appropriate fields in 
the Service Threads: Allocate by Priority window 

– When new values have been entered in all fields to 
be modified, click on the OK button 
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Cache Manager Server 
Configuration Dialogue 
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Service Threads: Allocate Threads 
by Priority Window 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Modifying PriorityThread Table Values in the 
Database Using the EcDsDdPTEdit.pl Script 

– EcDsDdPTEdit.pl script is a tool that can be used to 
change the limits for priority levels of threads in the 
DsDdPriorityThread database table 

– Script operates in either of two modes: 
» Interactive (menu driven) 
» Non-Interactive (command line) 

– Effects on system functioning and performance 
must be considered before modifying system 
parameters 

– When making or requesting a change to system 
parameters, the CM process at the particular site 
must be followed (if applicable) 

– Depending on circumstances at a particular site, it 
may be necessary to request that the Database 
Administrator modify database parameters 89 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Modifying PriorityThread Table Values in the 
Database Using the EcDsDdPTEdit.pl Script: 
Procedure 

– Access a terminal window logged in to the 
Distribution Server 

– Type script command in either interactive or non­
interactive format (as applicable) 

– Respond to menu prompts for entering new 
value(s) for the number of priority threads (if 
applicable) 

– Save new values 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Modifying System Parameters in the Database 
Using ISQL 

– Effects on system functioning and performance 
must be considered before modifying system 
parameters 

– When making or requesting a change to system 
parameters, the CM process at the particular site 
must be followed (if applicable) 

– Depending on circumstances at a particular site, it 
may be necessary to request that the Database 
Administrator modify database parameters 
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Modifying System Parameters in 
the Database (Cont.) 

•	 Modifying System Parameters in the Database 
Using ISQL: Procedure 

– Access a terminal window logged in to the 
Access/Process Coordinators (APC) Server 

– Log in to isql 
– Specify the proper database name 
– Check the current contents of the ThreadName and 

ThreadLimit columns in the DsDdPriorityThread 
table 

– Update the appropriate rows in the 
DsDdPriorityThread table 

– Verify table update by checking the current 
contents of the ThreadName and ThreadLimit 
columns in the DsDdPriorityThread table 

– Quit isql 
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Troubleshooting Data Distribution 
Problems 

• Troubleshooting: 

process of identifying the source of problems 
on the basis of observed trouble symptoms 
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Troubleshooting Data Distribution 
Problems (Cont.) 

•	 Problems with data distribution can usually 
be traced to… 

– some part of the Data Server Subsystem 
» Data Server Subsystem (DSS) 
» Science Data Server 
» Storage Management 

– problems in other ECS subsystems, including (but 
not necessarily limited to): 

» Communications Subsystem (CSS) 
» System Management Subsystem (MSS) 
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Troubleshooting Data Distribution 
Problems (Cont.) 

• Troubleshooting table 
– describes actions to be taken in response to some 

common data distribution problems 
– if the problem cannot be identified and fixed 

without help within a reasonable period of time, call 
the help desk and submit a trouble ticket in 
accordance with site Problem Management policy 
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Troubleshooting Data Distribution 
Problems (Cont.) 

Symptom Response 

Unable to log in to any host (e.g., 
Distribution Server, g0dis02). 

Check with the Operations Controller/System Administrator to 
ensure that the host is “up." 

GUI not displayed when the start-up 
script has been properly invoked. 

Ensure that the DISPLAY variable was set properly. 
[For detailed instructions refer to the procedure for Launching the 
Data Distribution Operator and Storage Management Control 
GUIs (previous section of this lesson).] 

Error message associated with the 
Data Distribution Operator GUI. 

Refer to Table 3, Data Distribution Operator GUI User Messages 
(adapted from the corresponding table in 609-CD-600-001, 
Release 6A Operations Tools Manual for the ECS Project). 

Request status change to 
“Suspended with Errors,” indicating 
a data distribution failure. 

1. Ensure (e.g., using ECS Assistant) that the necessary hosts 
and servers (listed in Table 4) are “up.” 
2. If hosts/servers have gone down, notify the Operations 
Controller/System Administrator to have servers brought back up. 
3. If hosts/servers are all “up,” notify the Operations 
Controller/System Administrator to have the STMGT servers 
bounced (shut down and immediately restarted). 
4. Resume processing of the suspended request. 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests (previous 
section of this lesson).] 
5. If processing does not resume, refer to the procedure for 
Recovering from a Data Distribution Failure (subsequent 
section of this lesson). 
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Troubleshooting Data Distribution 
Problems (Cont.) 

Symptom Response 

Other problems. Check the log files (e.g., EcDsDdistGui.ALOG, 
EcDsDistributionServer.ALOG, EcDsStStagingDiskServer.ALOG, 
EcDsStCacheManagerServer.ALOG) in the 
/usr/ecs/MODE/CUSTOM/logs directory of the Distribution Server 
host for error messages. 
[For detailed instructions refer to the procedure for Checking Log 
Files (subsequent section of this lesson).] 
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Hosts, Servers, Clients and Other 
Software Relevant to DDIST 

HOST SERVER/CLIENT/OTHER SOFTWARE 

Distribution Server (e.g., x0dis02) Data Distribution Operator GUI (EcDsDdistGui) 
Distribution Server (EcDsDistribution Server) 
Staging Disk Server (EcDsStStagingDiskServer) 
Storage Management Request Manager 
(EcDsStRequestManagerServer) 

Working Storage (e.g., x0wkg01) HDF EOS Server (EcDsHdfEosServer) 
Archive Server (EcDsStArchiveServer) 
Cache Manager Server (EcDsStCacheManagerServer) 
FTP Server (EcDsStFtpServer) 
Staging Disk Server (EcDsStStagingDiskServer) 

SDSRV Server (e.g., x0acs03) Science Data Server (EcDsScienceDataServer) 

Access/Process Coordinators (APC) 
Server (e.g., x0acg01) 

Archive Server (EcDsStArchiveServer) 
Cache Manager Server (EcDsStCacheManagerServer) 
FTP Server (EcDsStFtpServer) 
Staging Disk Server (EcDsStStagingDiskServer) 
Pull Monitor Server (EcDsStPullMonitorServer) 

FSMS Server (e.g., x0drg01) Archive Server (EcDsStArchiveServer) 
Cache Manager Server (EcDsStCacheManagerServer) 
FTP Server (EcDsStFtpServer) 
Staging Disk Server (EcDsStStagingDiskServer) 

Ingest Server (e.g., x0icg01) Registry Server (EcCsRegistry) 

Interface Server 02 (e.g., x0ins01) Subscription Server (EcSbSubServer) 
Event Server (EcSbEventServer) 98 
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Recovering from a Data Distribution 
Failure 

• Recovering from a data distribution failure 
– Operator intervention may be required when there 

is a data distribution fault or error (e.g., failure of 
storage management to acquire granules from the 
archive) 

– Ingest/Distribution Technician may use several 
sources for troubleshooting information 

» Data Distribution Operator GUI Distrib’n Requests 
tab 

» log files on various host machines 
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Recovering from a Data Distribution 
Failure (Cont.) 

• Procedure 
– Review the trouble symptoms 

– Check for requests that exceed the distribution 
request threshold 

– Check for an acquire failure 

– Check appropriate log files as necessary 

– Take action to correct the problem(s) 

– Verify that distribution request processing has 
resumed 
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Responding to Requests that 
Exceed the Dist. Request Threshold 

•	 When a distribution request exceeds the 
corresponding distribution request threshold 
(e.g., FtpPushThreshold or FtpPullThreshold), 
the request is suspended in DDIST with the 
following error mnemonic: 

– DsEDdXLargeRequest 
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Responding to Requests that 
Exceed the Dist. Request Threshold 

• Procedure 
– Contact User Services to determine whether or not 

the user’s request should be processed 
– If the request should be aborted, cancel the data 

distribution request 
– If the request should be completed, first determine 

whether the request should be resumed 
immediately or should be left suspended until an 
off-hours period when the system is less loaded 

» Another alternative may be to submit a request to the 
Database Administrator to increase (at least 
temporarily) the corresponding threshold 

– If the request should be completed, resume 
processing of the data distribution request 
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Handling an Acquire Failure 

• Procedure 

– Check the Science Data Server ALOG File 

– Check the Archive Server ALOG File 

– Check the Staging Disk 

– Check the Staging Disk ALOG File 

– Check the Space Available in the Staging Area 
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Checking Log Files 

•	 Log files can provide indications of the 
following types of problems: 

– DCE problems 

– Database problems 

– Lack of disk space 
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Checking Log Files (Cont.) 

• Procedure 
– Access a terminal window logged in to the 

appropriate host 
– Change directory to the directory containing the 

data distribution log files 
» /usr/ecs/MODE/CUSTOM/logs 

– Review log file to identify problems 
– Respond to problems 
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Checking Database Connections 

•	 Storage management/data distribution shared 
database 

– Repository of data concerning data distribution 
requests 

– If applications are unable to connect to the 
database, the data distribution request data cannot 
be retrieved or displayed on the GUI 

– Checking the database connections is a logical step 
in trying to isolate the following types of problems: 

» GUI does not display data 
» Display does not refresh 
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Checking Database Connections 

• Procedure 
– Submit a request to the Database Administrator to 

identify the values for the following parameters 
associated with the EcDsDistributionServer: 

» DBName 
» DBServer 
» DBMaxConnections 

– Use the interactive structured query language (isql) 
sp_who command to obtain a list of connections 

– Use the isql sp_configure command to obtain a list 
of the number of connections for which the 
database has been configured 

– Compare the number of actual connections (results 
of sp_who) with the number of connections for 
which the database has been configured (results of 
sp_configure "user connections") 

– Notify the Database Administrator of problems 107 
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